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Abstract
Being able to create digital geological maps has become a basic requirement for the skillset of today’s geologists. QGIS 

is a geographical information system that receives increasing popularity due to its user-friendliness and the fact that it is 
an open access software. This contribution provides an update and extension to a previously published software guide-
line that gives a stepwise explanation on how to create a geological map with QGIS. The article serves as a brief overview 
of the guideline through an illustrated example. The guideline itself is published as a supplement to this paper.  Within six 
sections, the guideline explains how to create a geological map with QGIS: 1. Introduction, 2. Download and installation, 
3. Basemaps, 4. Map drawing, 5. Plugins, 6. Layouts. The aim is to instruct geologists who are completely inexperienced 
with digital map creation as well as provide specific information for more advanced users. In general, providing software 
guidelines for the geological community is an important step towards increasing geologists’ digital proficiency and to 
keep up with today’s fast paced developments in digitalization.

1. Introduction
In recent decades, the application of digital technolo-

gy in geosciences has experienced a remarkable surge, 
both in practical and academic contexts. Digital mapping 
has historically been linked to advances in computing 
power, software and widespread availability and afford-
ability of both. For example, the first considerations on 
mapping automatization (albeit in a broader, geographi-
cal context) stem from the 1950s (Tobler, 1959). However, 
truly digital (i.e. “paper-less”) mapping in the field only 
became a practical approach in the 1990s to early 2000s 
with the advent of adequate portable devices (e.g. Briner 
et al., 1999). Regardless of whether the starting point is a 
hand-drawn map and field notes or digital field record-
ings, digital mapping requires a structured workflow. 
This imposes additional skill requirements on the mod-
ern geologist, but greatly increases the overall quality of 
the final product.

Finished geological maps for use in the academic and 
the applied world must be supplied in a digital format, 

preferably generated with a geographical information 
system (GIS). Most universities that provide geology 
studies today also offer courses on GIS based mapping, 
either as part of a wider geoinformatics education (e.g., 
the University of Innsbruck, Austria) or as dedicated field 
courses (e.g. UC Riverside, USA). However, there is still a 
need for additional and openly available guidelines on 
how to produce a digital geological map. Many universi-
ties’ GIS courses are not compulsory in the relevant cur-
ricula and thus do not reach the entirety of students (e.g. 
the University of Vienna, Austria). Furthermore, university 
GIS courses are often aimed at a broader student body 
(including geography and meteorology students) and do 
not necessarily cover the specifics of geological mapping, 
especially on the undergraduate level. In addition, these 
courses seem to mostly use proprietary software (e.g. Arc-
GIS). Geologists whose university education dates back 
some time may not have had the chance to take a course 
in digital mapping altogether as these classes were not 
yet part of the curriculum. Lastly, the authors experience 
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from the field of applied geology shows that many com-
panies still produce maps with inadequate programs (e.g. 
computer aided design (CAD) programs). This highlights 
both an insufficient knowledge of today’s open-source 
GIS possibilities as well as the economic threshold that is 
associated with some proprietary GIS programs.

QGIS is an open source, freely available GIS software 
that is licensed under the GNU General Public License. 
It provides an ever-increasing number of tools to create, 
edit and visualize geospatial data that is supported by a 
community of volunteers and different institutions (QGIS 
Development Team, 2023). Due to that, the popularity of 
QGIS has rapidly risen over the past years and is also in-
creasingly popular for geoscientific applications from be-
ginner to professional levels (Bartolini et al., 2013; Muen-
chow et al., 2017; Fang et al., 2020; Lemenkova, 2020; 
Penasa et al., 2020; Titti et al., 2022)

With this background, we introduce a guideline on 
the creation of geological maps with the open-source 
program QGIS. We build on the experience gained from 
an earlier guideline  “Geological Maps with QGIS 3.X” by 
Erharter (2018) (see also Erharter and Palzer-Khomenko, 
2018), which provides likewise provides a step by step ex-
planation on how a digital geological map can be creat-
ed with the freely available software QGIS. By the time of 
this writing, this earlier guideline has reached more than 
11000 “reads” on the platform “Researchgate” within ap-
proximately four years. While “Researchgate reads” are 
not a commonly used metric to measure the impact of 
publications, we still see it as a valid parameter for the en-
gagement rate of the community with a publication and 
it therefore shows that software guidelines such as the 
one presented here answer to a demand of the world-
wide geological community and contribute to geolo-
gists digital proficiency. Even though the “Researchgate 
reads” demonstrate the impact of such a work, the reader 
is encouraged to cite this work if the provided guideline 
is used for their own scientific studies.

Other tutorials on the use of QGIS for geological map 
creation such as Lorscheid (2013) or Mohsen Alshaghdari 
(2017) exist, as well as comprehensive compilations of 
tutorials for QGIS without specific reference to geologi-
cal topics (e.g. Gandhi, 2023). With around three bigger 
updates per year, QGIS is further developed rapidly and 
thus guidelines may become outdated after some years. 
The present work presents an up-to-date tutorial on cre-
ating geological maps with QGIS and is the first of such 
tutorials to include new features such as 3D map layouts.

2. Basic steps of digital geological map creation
The basic steps of creating a digital geological map 

are: i) data acquisition in the field, taking into account 
the overall investigation goal and desired map content; 
ii) transferring field data into a coherent data structure 
for mapping; iii) preparing basemaps on which the new 
map can be built; iv) adding own content to the map, i.e., 
map drawing; v) optional: creating additional map con-

tent such as cross sections and stereonets; vi) compiling 
the whole content in a publishable layout. The guideline 
published as supplementary material to this paper fol-
lows that overall structure. Nevertheless, the individual 
steps shall be briefly elaborated in the following section:

i) While the field data acquisition is not directly part 
of the map creation, it is generally advisable to follow 
an overall approach of systematic and digital data acqui-
sition (e.g. by using digital outcrop protocols (Brodaric, 
2004; Clegg et al., 2006; Dey and Ghosh, 2008; Horner 
et al., 2016; Allmendinger et al., 2017; Muir and Vaughan, 
2017)). This ensures that data is acquired consistently, no 
information is overlooked and vastly eases the transfer 
from field data to the computer by sparing one from 
hours of digitizing handwritten protocols. Despite the 
digital data acquisition, making a plan for the map before 
one goes into the field and to continuously update this 
plan with incoming observations is highly recommend-
ed.

ii) Before the digital map creation can begin, it is rec-
ommended that the field observations are stored in a 
consistent file and folder structure if this is not already 
provided by the digital outcrop protocol. The geologi-
cal map will follow a hierarchical structure (Bichler et al., 
2018), where layers of information overlap each other and 
this structure should correspond to the overall data man-
agement of the project.

iii) Basemaps are usually added to a map before the 
own content is added to provide a proper “mapping 
background” and eventually enhance the map with third 
party content. These base maps can comprise orthopho-
tos, digital elevation models and their derivatives (e.g. 
hillshades or slope maps) or other thematic maps. Base-
maps can have different datatypes such as content from 
the internet (e.g., web map services) or raster data.

iv) Map drawing is the act of adding one’s own content 
to the map and can follow different strategies. Adding 
geometrical elements (points, lines, polygons) directly to 
the map is a straightforward approach that might work 
well in many simple cases but poses the risk of creat-
ing topological inconsistencies in the map. The method 
“map drawing with contacts” is an alternative approach 
where one only draws the contacts as lines on the map 
and then intersects them with each other to automati-
cally create polygons. This has the advantage of creating 
topologically flawless maps and is also more robust to-
wards potentially necessary updates of the map, e.g., if a 
lithological contact needs to be changed.

v) Many geological maps are enhanced with additional 
information such as cross sections or stereonets of ori-
entation data. Highly use case specific content like this is 
usually created with software outside of the GIS environ-
ment or with plugins and modules.

vi) The last step of map creation is usually to compile 
everything in a publishable, informative, and visually ap-
pealing layout. Just as the digital map creation should be 
considered while field data is acquired, the final layout 
should be considered during the digital map creation. 
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Producing a publishable map can come with consider-
able efforts and even require changes to the map itself, if, 
for example, problems with the maps legend are discov-
ered at a late stage.

The guideline presented in the supplementary ma-
terial guides the reader through the basic steps listed 
above (except the first step, as detailed instructions on 
geological field work are outside the scope of this work). 
We present solutions to frequently encountered prob-
lems and caveats; however, is essential to clarify that the 
outlined procedure for creating a geological map using 
QGIS is not the exclusive or definitive method. While we 
consider it to be an efficient and reliable approach, alter-
native techniques may also be suitable. Moreover, it is 
crucial to note that the guideline does not pursue specif-
ic geological research objectives, and the authors do not 
assert the absolute accuracy of the presented geological 
data.

Additionally, it is pertinent to acknowledge that the 
instructions provided in this guideline go beyond QGIS 
alone. The principles and methodologies discussed here-
in can be extrapolated to other software platforms, in-
cluding but not limited to ArcGIS and similar tools. By 
adopting this broader perspective, we strive to offer a 

comprehensive understanding of the geological map 
creation process, applicable across various software en-
vironments. 

3. Revised guideline for geological maps with QGIS
The development of QGIS is driven by a vibrant com-

munity resulting in frequent updates and changes. Since 
the writing of the previous guideline by Erharter (2018), 
several new capabilities have been added. This paper 
accounts for this evolution by presenting a revised and 
extended version of the guideline in the supplementary 
material: it covers newer QGIS versions but also contains 
more topics such as state of the art strategies of geolog-
ical map drawing, the geoprocessing toolbox of QGIS, 
geopackages vs. shapefiles, plugins or 3D map layouts. 
Additionally, the guideline is now built around a “real 
world“ example of a geological map (part of the official 
Geological Map 1 : 50.000 Holzgau of the Geological Sur-
vey of Austria (Gruber et al., 2022) ). The entire map sheet 
is located in the North-Western part of Tyrol (Austria), 
most entirely in the Northern Calcareous Alps and also 
covers a part of neighboring Bavaria (Germany). Figure 1 
shows the final geological map that is produced through-

Figure 1: The final geological map that is produced throughout the QGIS guideline that is in the online supplement to this paper with the data pro-
vided in the link.
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out the guideline in the online supplement to this paper 
for geological maps with QGIS. The supplementary data 
to reproduce the map that is created within the guideline 
is available under the following link:

https://repository.tugraz.at/records/57kxm-w5t95?to-
ken=eyJhbGciOiJIUzUxMiJ9.eyJpZCI6Ijk0MDQ2N-
j R i LT M 2 O G Q t N G V l M C 1i N W Z m LTA 5 N 2 M 5 Y W -
FkNzNlZSIsImRhdGEiOnt9LC JyY W5k b20iOiI1Y T-
JhNzJiM2Q5MjRhOTc3ZTliODA1NjhlMTNjOTI5YSJ9.
AUAmv39oYNv-v6hO3A5538p234Q3J3fgvp0X1kg6BX-
oE5a_8P2K6rYfzlH-EY67RBibkjPYkc6K_Zr6GS9WGBA
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1. Introduction 

The knowledge about software usage in general and for GIS applications in particular is heterogeneous in the 

geoscientific community. With this tutorial, we provide a stepwise instruction on how to create a geological 

map to ease the start for inexperienced users. The present guideline is the revised version of the “Geological 

Maps with QGIS 3.X” guideline (Erharter, 2018) that was produced by the working group on “Digital Geology 

- DiGeo” of the “Austrian Geological Society” in 2018. With over 10000 “reads” in four years on the platform 

Researchgate, the first version of the guideline has shown that there is a need in the geoscientific community 

for entry-level software guidelines and we invite the interested user to cite the paper to which this is the 

supplement in their work. Answering to this need, the goal of the revision is to update the guideline with 

respect to new developments of QGIS and to extend it with additional topics. 

QGIS is an open source, freely available geographical information system (GIS) that is licensed under the GNU 

General Public License. It provides an ever-increasing number of tools to create, edit and visualize geospatial 

data that is supported by a community of volunteers and different institutions; http://www.qgis.org - QGIS 

Development Team (2023). QGIS’s popularity has rapidly risen over the past years and is also becoming 

increasingly popular for geoscientific applications from beginner- to professional levels (e.g. Bartolini et al. 

(2013); Muenchow et al. (2017); Fang et al. (2020); Lemenkova (2020); Penasa et al. (2020); Titti et al. (2022)). 

The guideline is built around a „real world“ example of a geological map which is a small part of the official 

Geological Map 1:50.000 “Holzgau” of the Geological Survey of Austria (GBA, now GeoSphere Austria) (Gruber 

et al., 2022). The map sheet is mostly located in the North-Western part of Tyrol (Austria) and almost entirely 

in the Northern Calcareous Alps (NCA). It also covers a part of neighboring Bavaria (Germany) (Figure 1). A 

small area of the official map sheet (Figure 2) was chosen as a case study as it contains geological features, 

which are not excessively complex geologically and are therefore ideal for this tutorial. Nevertheless, some 

important components of a geological map (e.g., structural displacement of geological units) can still be found 

in this example. The workflow is demonstrated by digitizing an analog geological map, provided by the leading 

geologist of the map sheet, Alfred Gruber of the Geosphere Austria. 

First steps like download and installation of QGIS are explained in section 2. To have a proper basis for further 

map creation, section 3 explains how various types of background maps or basemaps can be added to the 

project. In section 4, actual map creation is demonstrated by adding point, line, and polygon elements. Section 

5 shows an example of how external (3rd party) plugins can be used for more specific tasks of geological map 

generation. Instructions on how to make an informative and visually appealing final layout (in 2D and 3D) for 

export and display of the map are given in section 6. 

On the one hand we explicitly state that the presented way of map creation is neither perfect nor the only 

one to create a geological map with QGIS but in our view a good guideline to address this task. On the other 

http://www.qgis.org/
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hand, we emphasize that no geological research goal is pursued within this paper and the authors do not 

guarantee for the correctness of the presented geological data. The final map created over the course of this 

tutorial is shown in Figure 3. A link to the entire QGIS project is given in the Supplementary Information. 

 

Figure 1: Location of the map sheet “Holzgau”, scale 1:50.000, western Austria. A subsection is used as an example for this guideline. 

 

Figure 2: Map showing the position of the map sheet Holzgau 1:50.000 and the study area used in this guideline. A digital elevation 
model (DEM) is presented as a base map to show the alpine character of the area. 
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Figure 3: The final geological map as produced during the tutorial. 

An in-depth description and further information about the program and its functions is given in the official 

QGIS documentation. Button icons were taken from there as well: https://www.qgis.org/en/docs/index.html 

This tutorial is made for the Windows-based version of QGIS. The used QGIS version is the long-term release 

of QGIS 3.22.5 which was published in March 2022. We tried to stick to the basic installation of QGIS except 

for using the additional plugin “QProf” in section 5, which is a handy tool for creating geological cross sections 

based on geological maps in QGIS. 

Throughout the tutorial you will find further information beyond the main instructions with special formatting: 

Additional background information to certain topics will be given between blue lines, in italic, blue letters like this sentence. 

Useful tips will be given in italic, dark red letters like this sentence. 

  

https://www.qgis.org/en/docs/index.html
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2. First steps 

2.1. Download and Installation 

The open source geographical information system QGIS can be downloaded for free from: 

https://www.qgis.org → Download Now. 

On the following page you can choose the version that suits you best. 

Usually, you should pick the 64bit version if you are using a 64bit OS, but some plugins are only working with the 32bit version of QGIS. 

The newer versions (starting with the version 3.20) are only available as 64bit versions. 

Follow the installation assistant step by step. At the end of the installation, a folder will be created on your 

desktop (or wherever you choose to save it) which contains the link to the program “QGIS Desktop 3.x”. → 

Double Click to launch. 

2.2. Program Start – New Project 

After initializing the program, you will see the QGIS graphical user interface (GUI) (Figure 4). The GUI is highly 

customizable. For example, by right clicking the toolbar, or via View → Toolbars, you can add additional tools 

and panels to the GUI. For this tutorial, it is recommended to add the “Advanced Digitizing Toolbar”, the 

“Manage Layers Toolbar”, the “Snapping Toolbar”and the “Processing Toolbox Panel”. 

 

Figure 4: QGIS graphical user interface: 1. Menu bar, 2. Toolbars, 3. Panels, 4. Map window, 5. Status bar, 6. Toolbox Panel. 

https://www.qgis.org/
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To start a new project, press the New button  on the upper left side of the toolbars. 

Before we add content to the map it should be noted that GIS programs like QGIS work differently than many 

other programs of daily use. The project that you are working on is saved as a .qgz file, but you will notice that 

even as your project grows, this file does not increase too much in size. The reason is that QGIS only establishes 

connections to other files from the project file. Consequently, when you edit a layer in QGIS, you actually edit 

a specific file (e.g. raster file, vector file etc.) and therefore you will also always need to enable and disable the 

editing mode for every modification that you want to do. While this might seem somewhat cumbersome at 

first, it has the advantage that you can access content of maps from multiple projects which ultimately saves 

disc space as information only needs to be saved once. At this point however, only keep in mind that your .qgz 

file will be linked to many other files which should be considered when a basic folder structure is set up. 

Generally, the mapping functionality of QGIS is based on a stack of layers with different kinds of objects 

containing geometries and information. Before starting a new project, you should give some thought to the 

order of these layers which will help to keep your project well organized. For this tutorial a layer structure as 

shown in Figure 5 will be used (see also Bichler et al. (2018)). 

 

Figure 5: Data structure used in this tutorial (modified after Bichler et al. (2018)). 

Ideally, consider right from the start that the layers which are used for modeling will be used as parts of a map’s legend (see section 
6.1) during layouting. Consequently “legend-oriented” layer styling and assignment of names can save work later on. 

It is recommended to store all files of the project in an organized folder structure. For this tutorial, the simple 

folder structure of Figure 6 will be used. The project itself is saved  into a designated folder which contains 

two separate folders for raster- and vector-data. 

Well organized layer- and folder structures will save you lots of work (and headaches) later. 
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Figure 6: A simple folder structure for this tutorial. 

2.3. Coordinate Reference Systems 

By default, the coordinate reference system (CRS) is set to WGS 84 (EPSG: 4326). The actual CRS can be seen 

on the right side of the Status bar. By clicking the CRS symbol  or by Project → Project Properties → CRS 

you can switch between different CRSs. QGIS 3 shows you a preview of the CRS boundaries. This allows you to 

check whether you have selected a valid system (Figure 7). For the exemplary project that we show in this 

tutorial the CRS “MGI / Austria Lambert” with the EPSG code 31287 is used. This CRS was chosen because it is 

valid for whole Austria. By doing so we change our CRS from WGS 84 which is a geographical coordinate system 

(GCS) into “MGI / Austria Lambert” which is a projected coordinate system (PCS). Going into detail of GCS and 

PCS is not part of this tutorial as this would go beyond the scope. Nevertheless, please be aware that the CRS 

used for the final layout of the map is “MGI / Austria GK M28, EPSG code 31257”. This is due to the projection 

of the data in the MGI Austria Lambert CRS which is slightly tilted in the west of Austria. Note that, by default, 

QGIS reprojects data to the currently set CRS, regardless of the input data’s CRS (“on-the-fly projection”). This 

ensures that everything is displayed in the correct location. However, every time when data with a diverging 

CRS form the currently set CRS is added, or the CRS is changed in Project Properties or a CRS is reprojected, it 

can be necessary to check which “Transformation” was used for the on-the-fly projection or reprojection 

between different CRS. This is especially important when multiple operations are possible for converting 

coordinates between CRS as the “wrong transformation” can lead to errors which are just a slight shift of 

“locations” in your data and often are not easily recognizable. QGIS 3 offers an automatic detection when 

more than one transformation is selectable. A window opens where you are asked to choose the appropriate 

transformation for your purpose (Figure 8). Furthermore, QGIS 3 offers more detailed information like the 

accuracy or the area of use for a transformation option. You can also enter the transformation window by 

clicking Project → Project Properties → Transformations. Please keep in mind that your data may still have to 

be reprojected to an appropriate CRS if you want to perform certain tasks or calculations that go beyond 

simple map display. 

Some CRS have very similar names to others, but the EPSG code of a CRS is a unique identifier. Adding the EPSG code in 
communication about CRS is therefore good practice and helps to avoid misunderstandings. 
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Figure 7: You can switch coordinate reference systems (CRS) easily within the Project Properties. QGIS3 gives you a preview of the CRS 
boundaries. 

 

Figure 8: You are asked to choose the correct transformation between different CRS if needed. QGIS 3 shows you the accuracy of a 
transformation and the area of use. 

2.4. Tutorial data 

In the supplementary information, we provide all the data we used or created throughout this tutorial (Figure 

9). Basically you can try to follow this tutorial step by step or you can more or less jump to any part of it using 



10 

the data you need from the supplementary information. We did on purpose incorporate the raster and vector 

data with different CRS as this is often the case in real life applications. The data mainly consist of a folder 

called “raster” which contains the analog geological map of the area (EPSG: 31257) and the stitched and 

clipped digital elevation model (DEM) (EPSG: 31254) (see 3.2) and of a GeoPackage (4.2) called “vector” which 

contains all the geometries of this tutorial (all EPSG: 31287). To hopefully save you a lot of headaches, we 

saved the symbology to all the vector data we used directly to the data. This is done in the symbology tab of 

the layer properties → Style → Save as Default → Datasource Database. Thus, when you load a vector 

geometry from the GeoPackage into your project you should automatically get the same symbology as it is 

applied through this tutorial. The tutorial data can be found here. In section 4, we explain in detail how to 

adopt and change the appearance of the data (“the symbology”) to your preferences. 

 

Figure 9: Tutorial data in the QGIS browser view. 

3. Basemaps 

The first step for the creation of a digital geological map by QGIS is to add a basemap to the project. It serves 

as the “background” on which new, individual information is presented. Basemaps can for example be general 

topographical maps, rasterized terrain data, scanned, old geological maps, digital geological maps, etc. Before 

adding data, Right Click into the Layers Panel and press Add Group . Call this group “basemaps” and insert 

all basemaps you want to use. 

In case of numerous base maps, subgroups may help to keep the project organized. 

3.1. Web Map Service 

Web map service (WMS), web feature service (WFS) or web coverage service (WCS) are possibilities to access and implement layers of 
geographic information from remote servers, without the need of storing additional data on your computer. Public institutions often 
provide a variety of geographic information via these services, including recent and historic orthophotos, hillshades, topographical 
maps and even geological maps! 

Web Map Services (WMS) constitute an additional data-source that can be used as a background for a project 

but it should be noted that a WMS layer is only an image and without further information. This is e.g. an issue 

when a Digital Elevation Model (DEM) is added to a project as a WMS layer, where one can then see an image 

representation of the DEM but cannot access the actual height information of the model. 

https://repository.tugraz.at/records/57kxm-w5t95?token=eyJhbGciOiJIUzUxMiJ9.eyJpZCI6Ijk0MDQ2NjRiLTM2OGQtNGVlMC1iNWZmLTA5N2M5YWFkNzNlZSIsImRhdGEiOnt9LCJyYW5kb20iOiI1YTJhNzJiM2Q5MjRhOTc3ZTliODA1NjhlMTNjOTI5YSJ9.AUAmv39oYNv-v6hO3A5538p234Q3J3fgvp0X1kg6BXoE5a_8P2K6rYfzlH-EY67RBibkjPYkc6K_Zr6GS9WGBA
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Figure 10: Workflow to add a WMS layer to the project: 1. add new WMS; 2. connect to the service; 3. select the layer; 4. add layer. 

By pressing the Add WMS/WMTS Layer button  within the Manage Layers Toolbar, or by going Layer → 

Add Layer → Add WMS/WMTS Layer from the Menu bar, the Data Source Manager window pops up. Upon 

pressing New, another window pops up where you can enter the desired name and URL of the WMS. We will 

add several WMS layers to our exemplary project but start with an Orthophoto. Enter “Orthophoto Tirol” as 

“Name” in the “Connection Details” and this URL and confirm by pressing OK. Back in the Data Source 

Manager, press Connect, select the layer with the title “Aktuell_RGB” and finish with Add (Figure 10). 

In the same manner, we add two more WMS layers to the project and the details are given in Table 1. 

Table 1: Overview of the WMS background layers that are used in the example project. 

WMS Layer name Description URL 

Orthophoto Tyrol A RGB orthophoto of the whole 

province of Tyrol 

https://gis.tirol.gv.at/arcgis/services/Service_Publ

ic/orthofoto/MapServer/WMSServer?request=Ge

tCapabilities&service=WMS 

Open Street Map A publically available general purpose 

topographic map with information 

about landmarks. 

Error! Hyperlink reference not valid. 

 

Hillshade Tyrol A hillshade view of a high resolution 

digital elevation model of Tyrol which is 

well suited to identify morphologies. 

https://gis.tirol.gv.at/arcgis/services/Service_Publ

ic/terrain/MapServer/WmsServer 

https://gis.tirol.gv.at/arcgis/services/Service_Public/orthofoto/MapServer/WMSServer?request=GetCapabilities&service=WMS
https://gis.tirol.gv.at/arcgis/services/Service_Public/orthofoto/MapServer/WMSServer?request=GetCapabilities&service=WMS
https://gis.tirol.gv.at/arcgis/services/Service_Public/orthofoto/MapServer/WMSServer?request=GetCapabilities&service=WMS
https://gis.tirol.gv.at/arcgis/services/Service_Public/orthofoto/MapServer/WMSServer?request=GetCapabilities&service=WMS
https://gis.tirol.gv.at/arcgis/services/Service_Public/terrain/MapServer/WmsServer
https://gis.tirol.gv.at/arcgis/services/Service_Public/terrain/MapServer/WmsServer
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3.2. Raster data 

3.2.1. Adding raster data 

In contrast to the previously used web based map services, adding actual raster data to the project has the 

benefit that more information is available (e.g., height information in DEMs) but also the data needs to be 

stored locally. For this tutorial we will use a part of the DEM of Tyrol with a 1m resolution. In this case DEM 

tiles (i.e., segments) are provided by the province administration as downloading the whole 1m DEM of Tyrol 

is mostly not necessary and would result in a rather large file size. The individual tiles can be downloaded from 

this URL. To cover the whole area of interest the following tiles will be needed: 

• 1625-61 1625-62 1625-63 

• 1625-69 1625-70 1625-71 

• 1625-77 1625-78 1625-79 

When the individual tiles are downloaded, they will come in zipped folders that need to be unpacked first. 

Every folder will contain multiple files, but we will only need the files with the DEM height information that 

are named “dgm_1m_1625-XX_2019.tif”, where the XX stands for the individual tile number. The easiest way 

to add the raster data to the project, is to “drag and drop” them from their folders into the map window. 

Alternatively, you can press the Add Raster Layer button  in the Manage Layers Toolbar. In the following 

window, choose the raster file’s location on your computer and press Add. After adding the tiles to the map, 

QGIS automatically colorizes them according to a black-white colormap which spans from the lowest to the 

highest point in each tile (see Figure 11). 

 

Figure 11: The DEM tiles added to the exemplary map project. Each tile is automatically colored from black to white according to their 
lowest and highest points. The background is the previously added hillshade WMS layer. 

https://tiris.maps.arcgis.com/apps/webappviewer/index.html?id=5e3071044cb44e76843d110baef8b138
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Clear definitions of digital terrain/elevation/surface model (DTM, DEM, DSM) are controversial (Li et al., 2005). An old definition of a 
DTM is given by Miller and Laflamme (1958): “The digital terrain model (DTM) is simply a statistical representation of the continuous 
surface of the ground by a large number of selected points with known X, Y, Z coordinates in an arbitrary coordinate field.” In this 
tutorial DEM – in contrast to DSM - refers to raster data that represents the ground surface without vegetation and buildings. 

3.2.2. Using the “Geoprocessing Toolbox” 

QGIS comes along with a wide variety of predefined algorithms for processing geo-spatial data. In addition to 

internally available tools, it incorporates third party tools from external open source GIS applications like 

SAGA1, GDAL2 or GRASS GIS3 and gives the opportunity to create and use plugins. The toolbox contains 

solutions for a wide variety of tasks and is indispensable whenever you want to work with geospatial data, 

ranging from simple edits to advanced calculations. Basic algorithms are also situated in the Menu bar under 

Raster and Vector, but to get access to all available options the “processing toolbox panel” is the easiest way 

(number 6 in Figure 4). 

Due to the large number of available algorithms the search box on top of the panel is very useful. 

The algorithms are grouped into different blocks called “Providers” (eg. QGIS, SAGA, GRASS GIS,..) as wells as custom models and (self-
written) scripts.  

Due to the incorporation of several external applications, there is sometimes more than one tool available using the same algorithm, 
but with different sets of input. In general, they deliver the same or very similar results. Therefore, depending on the input available, it 
can be useful to try the different tools to test the best application for your use case. 

3.2.3. Merging raster data 

When raster files come in tiles as described in the previous section, it is recommended to merge them into 

one single file. To do this go to Raster → Miscellaneous → Merge. In the new window, select the raster tiles 

that should be merged (1 in Figure 12; beware you will also see WMS layers in there) and specify a new file (2 

in Figure 12) in the raster folder (see Figure 6) of the project. After this step the individual tiles can be removed 

and further processing can be done based on the single merged raster file. 

 
1 SAGA = System for Automated Geoscientific Analyses Conrad et al. 2015)  

2 GDAL = Geospatial Data Abstraction softwar library (GDAL/OGR contributers (2022)   

3 GRASS = Geographic Resources Analysis Support System (GRASS Development Team, 2022)   
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Figure 12: Settings for the raster merging tool that combines multiple individual raster into a new one. 

3.2.4. Clipping raster data 

The raster sizes in this case study is not too large and therefore it is not necessary to clip it. In other cases, 

however, you might have to deal with very large raster sizes that contain areas that are not of interest for the 

current project. To remove (i.e., clip / crop all unnecessary parts of the raster file) go to the Processing Toolbox 

panel and type in the search field Clip raster by extent and double click on it. 

 

Figure 13: Settings for the "Clip raster by extent" tool. 

In the following window, choose the correct “Input Layer” and the folder path where you want to save the 

clipped raster. Click the button next to the field “Clipping extent” (1 in Figure 13) and choose Select extent on 
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canvas. After you have chosen the desired extent on the map window by dragging a frame around it, click Run 

in Background. You will find the clipped part of the raster as a new layer “Clipped (extent)” in your layers 

panel. 

The new layer is only a temporary layer. To save it permanently, Right click it and choose Export - Save as. Within the Save Raster 

Layer as… window you can select different file types (choose the default GeoTIFF).  

3.2.5. Hillshade, slope, contour lines 

By default, QGIS chooses a “singleband gray” rendering to display raster data. This style colorizes the raster 

layer with a black to white gradient from the lowest to the highest point which is sometimes not the graphically 

most appealing and informative style. By choosing Raster → Analysis → Hillshade from the Menu bar you can 

add a raster layer with a shaded view of the terrain which is a more 3D looking style (see e.g. the foreground 

and background of Figure 11). Note that hillshades can only be rendered correctly if a projected coordinate 

system is used, otherwise it needs to be reprojected. 

Most commonly, hillshade renderings are displayed illuminated from 315° (i.e., from the north-west) at an altitude of 45°. This is also 
the default setting in QGIS, but feel free to apply different azimuths and altitudes of the light source to your DEM and see how the 
visibility of morphologies changes under different settings. 

 

Figure 14: Settings in the symbology of the slope view. 

Another option is the “slope” view which assigns a (continuous) colorband or discrete colors to the raster layer 

depending on its steepness: Raster → Analysis → Slope. The settings are modified in a way that we change 

the color gradient from “Black to White” to “White to Black” (1 in Figure 14) and change the “Min” and “Max” 

values to 0 and 90 respectively (2 in Figure 14). 
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Extracting contour lines from the height values of the DEM (note: not the Slope view) is possible by clicking 

Raster → Extraction → Contour. For the final map of this tutorial (Figure 3) an “Interval between contour 

lines” of 100m is chosen and the style of the contour lines is changed so that the lines are black. 

When using these raster tools, always check whether the correct raster layer is chosen in the Input Layer field. A wrong input can 
easily lead to a weird output and extended computing time (e.g. using a hillshade raster to compute a slope view). 

Right click a new layer within the layer panel and select Properties. Choose from a wide range of 

customization options for styling your layers. By now, your project should look similar to Figure 15. 

 

Figure 15: QGIS GUI with some toolbar - and panel customizations (compared to Figure 4). A raster of a “Slope view” of the DEM has 
been added and contours with a spacing of 25m were extracted from the DEM. 

3.3. Georeferencing 

Georeferencing is the process of fitting (i.e. rotating, scaling and warping) maps to a CRS. This is done by marking points on the map 
where the coordinates are known and then transforming it accordingly.  

Scans of field maps usually lack spatial information. To add spatial information, you have to georeference your 

map. Therefore, you have to define the coordinates of at least three points within that map. Alternatively, you 

can georeference a map onto an already georeferenced map of the same area. As an example, the, scanned 

field map of the project area will be georeferenced to the already existing layers of the project by “pinning” 

together known geographical locations. 

The selected locations used for georeferencing should be evenly distributed over the map area, covering also 

the marginal areas. Additionally, the selected georeferencing points should not be aligned in straight lines. 
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To georeference a map, go to Raster → Georeferencer ... . To start, press Open Raster , load the un-

georeferenced map and select a CRS. The spatial information of your raster-file will be saved in that CRS. To 

add a new ground control point (GCP) (i.e.: point of known location) press Add Point  and click on the first 

point of the un-georeferenced map of which you know the location. You can now either enter known 

coordinates or select a point From Map Canvas. Confirm and proceed to add some known points. 

At least three known points evenly distributed across the map (even more for some types of georeferencing) are needed. Use 
distinctive points like crossroads, summits, churches, huts etc. for georeferencing, but be careful that the points are the same in both 
maps! A coordinate grid in the un-georeferenced map is usually the most reliable reference point. 

After you have added some points (Figure 16), open the Transformation Settings , choose a 

Transformation type (e.g. “Linear” for very simple transformations), select the project CRS as “Target CRS”, 

select a location where the georeferenced map is supposed to be stored and check the “Load in QGIS when 

done” checkbox. 

 

Figure 16: GCPs (red dots, in red circles for better visibility) added to a scanned field map. 

QGIS offers several other (more sophisticated) Transformation Types that are worth checking out in case you deal with heavily 
distorted maps (e.g., historical maps). 
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The small red lines at your GCPs will now give you a preview of the transformation. Start Georeferencing  

and feel free to save the GCPs (often not necessary). The scanned map will now appear in your map window 

and you can check whether or not it is in the correct place (Figure 17). 

 

Figure 17: A georeferenced, scanned field map. 

Note that the scanned field map of the tutorial area is already georeferenced available in the tutorial data (supplementary). 

4. Map drawing 

4.1. Basic strategies and approaches 

Every geological map is a representation of its underlying geological model which tries to abstract the reality 

for a distinct purpose as well as possible (Strasky et al., 2012). With GIS techniques, a “simple drawn” map can 

be transformed into a sophisticated database-related work-environment. This guideline is focusing on a basic 

way to create a geological map in QGIS, that is, separating the information in the three main geometries 

(polygons, lines, points) which can be found in a GIS. Although information is separated into geometries, 

please keep in mind that the ultimate goal of this guideline is a 2D map as a result of the geometry layers 

stacked on top of each other. 

The intuitive way of starting to create maps in the digital world is to directly draw polygons for each separate 

geological unit. Snapping and tracing tools are generally used to avoid typical topological errors such as 

overlapping polygons and empty spaces between polygons. This strategy works well in areas with large 
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polygons clearly separated from each other. However, the occurrence of topological errors cannot be 

completely avoided, even by experienced GIS users, and their correction can be quite time-consuming. 

Therefore, depending on the use-case we suggest two strategies that may be applied. On the one hand, if the 

use-case is to digitize an already finished geological map, we highly recommend the method “map drawing 

with contacts” (see section 4.1.1 for information, and sections 4.3, 4.4, 4.4.1 for a practical guide) as it offers 

some significant advantages. On the other hand, if the use-case is to build up a geological map by adding 

geological information piece by piece and time by time, the iterative method where geological units are drawn 

as polygons may be more efficient. If you want to use this case, jump to section 4.5, where drawing polygons 

is explained. 

The approaches to digitize the respective maps may also differ from topic to topic, e.g., as the crystalline rocks 

should cover the whole mapping area, the contact/construction lines approach might be the favourable one. 

However, since Quaternary sediments are generally not covering the whole area, the approach of drawing 

singular polygons might be the better approach. 

4.1.1. Basics of geological map drawing with contacts 

In the classical analog method of constructing geological maps, contacts between geological units have the 

highest importance (Compton, 1962) and this concept is still applicable. Therefore, it is highly recommended 

to start a map by drawing lithological, lithostratigraphic, tectonic or other kind of geological contacts as a 

construction line layer. Once this “contacts” layer is finished, it can be transformed into a polygon layer and 

filled with information (attribution) about the geological units. Furthermore, the so drawn tectonic contacts 

can be copied and used as a tectonic-line layer. Using this approach automatically follows the topological rules 

which are described below. 

While we generally recommend following this approach of map creation, "map drawing with contacts" can 

come with challenges in some situations. In mountainous areas with pronounced topography, the bedrock 

surface under the sedimentary cover might be complex and thus the assumed geological contact hard to 

construct. This challenge gets amplified in cases of low information density, e.g., when geological contacts are 

only sparely exposed, no underground exposures (drillings) are available etc. In cases like this, the "map 

drawing with contacts" approach can be combined with simple polygon drawing based approach (section 4.5) 

which can be applied in difficult areas. 

4.1.2. Basics of geospatial topological rules 

“Geospatial topology is the study of spatial relationships between geographic features” 

(https://en.wikipedia.org/wiki/Geospatial_topology). In the practical work in GIS, this concept can be used to 

https://en.wikipedia.org/wiki/Geospatial_topology
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come up with topological rules for the used geometries (point, lines, polygons) which can be semi-

automatically controlled and corrected and therefore raise data-quality immensely. 

• Topological rules for the polygon-geology-layer 

The lowermost layer in a geological map is usually a polygon layer, bearing the information of its geological 

composition (lithology, lithostratigraphy, tectonic-units, etc.). This layer is per definition seamless (geology is 

everywhere in the underground) which correspond to the topological rule “must not have gaps” and as we 

are dealing with a 2D map, the polygon geometries should not cross themselves which correspond to the 

topological rule “must not overlap”. 

• Topological rules for the tectonic-lines-layer 

Next to the geology-basis-layer, a layer with information of tectonic zones (represented as lines in 2D) confine 

and/or displace geological units (polygons), is typically part of a geological map. As described above, a contact 

between geological polygons can be either of tectonic or other geologically relevant (e.g., lithological) nature 

and leads to the following rule: If the tectonic line is the separator between geology polygons, the line must 

be exactly drawn on the underlying border of polygons which correspond to the topological rule “must be 

covered by boundary of XXXX”.  

4.1.3. Basic cartographic rules 

As mentioned above, the ultimate goal of this guideline and basically of every printable geological map is a 2D 

representation as a result of the geometry layers put on top of each other. To achieve this goal, some 

cartographic rules have to be followed. It is highly recommended to keep these rules in mind during 

drawing/digitizing. The most important rules are: 

1. Always think about the final scale of your map. For example, polygons should be of a big enough size 

to be represented as visible polygons in your final map. 

2. Use as many vertices as needed so that your linework (segments which build up the whole map) in 

your final scale looks smooth (not edgy) and as few as required that your work is efficient. As a rule of 

thumb: The narrower a segment is the more vertices are needed - Straight lines = few vertices, curves 

= more vertices (Figure 18). 
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Figure 18: Visualization of the rule of thumb that the narrower a segment is, the more vertices are needed. 

3. Avoid Sliver Polygons. Sliver Polygons are elongated thin polygons which are generated by putting 

different layers on top of each other. (Figure 19) They can be avoided when already existing segments 

are used again with snapping and tracing during drawing or digitizing. 

 

Figure 19: Try to avoid sliver polygons (left). Right is the correct equivalent. 

4.1.4. Basics of attribution 

Attribution is the process of adding information to geometries. Using GIS offers the possibility to use database-

related tools to tremendously speed up and control this attribution process. The most useful and common 

case is to store all information of the geological units in a separate table (legend table) and connect (join) this 

table to the geometries via a unique identifier using a 1: n relation. However, this guideline concentrates on 

very basic attribution using a unique identifier (value) and a description of it (legend) in the “layer styling 

tab” of the properties of a layer (Figure 20). Through this whole tutorial, all geological data is using a 6 digit 

unique identifier starting with HOL and 3 numbers (HOLXXX) indicating that the data stem from the map-sheet 

“HOLzgau”. It should be pointed out that the unique identifier (preferably short and logically built up) is a key 

feature of a well-designed geological map as it is used to label the geological units on the map and connects 



22 

the legend to the units, therefore guaranteeing the understanding even if the map is printed or presented e.g. 

not in color. 

 

Figure 20: Layer styling tab of the bedrock polygon layer. The HOLXXX keys serve as unique identifier and the Legend is the description 
to it. 

To assign attributes to geometries in QGIS, two different workflows can be applied. The first one is that an 

attribute window is opened after every drawn geometry which offers the opportunity to directly assign the 

attribute. The second on is that no attribute window is automatically opened and after finishing the 

geometries all the geometries which have the same attribution can be selected and attributed in one step. 

Depending on the use-case, the one or the other is preferable and sometimes also a mixture of both is best. 

For practical examples please look at section 4.3.2. 

A very handy feature of QGIS is to use tables as look-up tables to predefine the attributes (information) which can be assigned to a 
certain geometry. This is done in the “attributes form tab” in the properties of a layer using “value relation” as widget type. Also see 
section 4.5. 

4.1.5. Basics of symbology 

Geological data and their derivations and especially their representation on a map strongly depend on a self-

explanatory and clear symbology. A “good” geological map is able to offer a basic explanation of geological 

contexts simply through basic coloring and symbology. QGIS 3 offers a powerful symbol tool where layers of 

symbols can be stacked onto each other to generate nearly any representation needed. This so-called Symbol 

Selector (Figure 21) can be found via the Layer Styling Tab or in the Symbology of the Layer Properties. By 

clicking on the symbol next to any entry, it opens and you can design your own symbology or use previously 

designed symbols in the style manager . 



23 

 

Figure 21: The Symbol Selector with the example of a mass movement border generated by putting two line symbologies together. 

Alternatively, you can find further information on more symbology options like font-marker or svg-marker 

symbols in section 4.7.3. 

For details see https://docs.qgis.org/3.22/en/docs/user_manual/style_library/symbol_selector.html and 
https://docs.qgis.org/3.28/en/docs/user_manual/style_library/style_manager.html . 

4.2. GeoPackage vs Shapefile 

On a geological map, information is presented with points, lines and polygons. A “shapefile” is a common way 

to save such geometries. Although the shapefile (.shp) is a well-established file type, it is no longer state of 

the art and has therefore next to its advantages several drawbacks. The main advantage is the still very wide 

use and software compatibility. In addition it is easy to use and easy to share was the standard for more than 

20 years. One main drawback is that for every saved vector layer at least three files will be generated and 

these have be stored together. In bigger projects the amount of files could be therefore difficult to organize. 

These fact leads also to problems in case of sharing a big project or parts of it, moreover the symbology of the 

layer could not be stored within the saved file (at least it is possible with an additional style file). Furthermore 

the name length of attributes (columns) is limited to 10 characters which results most of the time in complex 

and often not intuitive attribute abbreviations. The new main-file type in QGIS3 is the “GeoPackage”, an 

“open, standards-based, platform-independent, portable, self-describing, compact format for transferring 

geospatial information” (http://www.geopackage.org/spec/). This file type offers the advantage that different 

vector layers can be stored in just one file with a size limit of 140 TB, therefore there is no need of a complex 

self-made folder data structure to organize vector data.  Further, on, it allows the storage of different feature-

classes (point, line and polygon) together as well as raster files. Attribute name lengths are much longer and 

support more character encoding schemes. Drawbacks are that the usage is less intuitive and not every GIS 

related software supports this format. 

For additional technical information on geopackages, the website http://www.geopackage.org/ is recommended. 

https://docs.qgis.org/3.22/en/docs/user_manual/style_library/symbol_selector.html
https://docs.qgis.org/3.28/en/docs/user_manual/style_library/style_manager.html
http://www.geopackage.org/
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4.2.1. Create a GeoPackage database 

In this tutorial, all vector data will be stored in a newly created GeoPackage database. To do this, a random 

data layer (No Geometry, point, line, polygon, etc..) must be created, because it is not possible to create an 

empty GeoPackage database. For a new database, open the Browser Panel and with a right click on 

GeoPackage choose “Create Database”(Figure 22) and save the database in your project folder. Name the new 

GeoPackage like your project name and choose a random geometry type as mentioned above, leave all other 

settings as they are and click OK. Now the new database is created and automatically connected to QGIS. At 

the same time the new created layer will be added to the Layers Panel. Within this example the layer was just 

created for a “non empty” GeoPackage and can be deleted in the Layers Panel. 

There are several ways to create a GeoPackage database. If another method is used, it is maybe necessary to connect the database to 
QGIS manually. This is also possible in the Browser Panel (New Connection…, Figure 22). 

In the Browser Panel the new connection appears under GeoPackage. By clicking on the triangle on the left 

hand side, all stored vector files within this database appear. It is now possible to add the included layers to 

the current project. 

   

Figure 22: Creating a new GeoPackage – database. 

For this tutorial we create a GeoPackage – database named “vector” (Figure 23), to store all the vector 

geometries we will create. 
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Figure 23: The created vector.gpkg (GeoPackage - database) in the browser view. 

It is also possible to add an existing single layer to a GeoPackage by using the Export function in the Layer Panel or more layers by 
using the toolbox function “Package Layers”. 

4.3. Construction line layer and mapping area boundary 

This tutorial is focused on the method of drawing geological lines (see 4.1.1) which are then further 

transformed into a polygon layer with geological information and a line layer with tectonic information. For 

this purpose, a mapping area boundary which defines the area of digitization is created. This boundary layer 

is highly important as this method only works properly if the geological lines in the construction line layer are 

closed - meaning that every end-vertex of a line connects to another vertex or an edge of another line. 

Furthermore, it also serves as a very useful boundary for all the other layers, to make sure that every layer has 

the same extent. This boundary layer can be either of a line or polygon geometry. In this case we use a polygon 

geometry. To create layers in “vector.gpkg”, right click on the file and choose “New Table”. First, the mapping 

area polygon layer is generated. An attribute (a field with information) is not needed, so the option of “add 

field” can be left out. Make sure to choose the correct geometry type (in this case polygon) and the correct 

CRS which is ideally the same throughout your whole project (in this case we always use EPSG 31287 – MGI 

Austria Lambert) (Figure 24). 
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Figure 24: Creating the Mapping Area polygon layer in the vector.gpkg. 

After that, the construction line layer is created. Since this layer needs an attribute (a field) with the 

information whether a drawn line is either a lithological or a tectonic contact, a simple text field is added. Use 

the “Add Field” button and create a new field of type “text” with the name “line_type”. Be aware to choose 

the correct geometry type (in this case LineString) and the correct CRS (Figure 25). 

 

Figure 25: Creating the construction line layer in the vector.gpkg. 

The layer tree in your gpkg should now look like this (Figure 26): 
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Figure 26: View of the layer tree with the created layer in the vector.gpkg. 

4.3.1. Drawing the mapping area boundary 

To draw the mapping area, load the georeferenced raster of the analog map (see section 3.2.1) into your layers 

tree as well as the “Mapping_Area” polygon geometry from your gpkg. To start the drawing process be sure 

to activate your “Mapping_Area” polygon (click on it in the layers tree). Toggle Editing  → Add Polygon 

Feature  and start “drawing” by clicking the desired place on the map. Follow the outlines of your analog 

raster. In this case this is a simple rectangle. Your map should look now like this (Figure 27): 

 

Figure 27: View of the analog geological map and the outlines of the mapping area polygon. 

Safe layer edits regularly  to avoid loss of progress. If the Toggle editing mode can’t be activated from the newly created 

GeoPackage layer it may help if you delete the layer in the layer tree and add it again from the browser pane. 

4.3.2. Drawing the construction line layer 

To draw the construction line layer, load your “construction_line” geometry into your layers tree and right 

click on it. Toggle Editing  → Add Line Feature  and draw a new line by adding vertices to the map. 
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Enable Snapping  (Shortcut “S”) and adjust its functionality in the Advanced Configuration . Make 

sure to use snapping when you are closing your geological lines/contacts as the derived geological polygon 

will only be created later on, when your constructional linework is closed correctly (Figure 28). Attention: The 

tectonic contacts are allowed to not close because their parts which are not simultaneously a lithological 

contact will not be used for deriving the polygon layer (Figure 29). Use Tracing  to follow the 

Mapping_Area polygon to digitize the outline in the construction line layer (this is important for deriving the 

polygon-layer).  

 

Figure 28: Closing the linework with snapping; left = not correct, right = correct. 

 

Figure 29: Exception: The ends of tectonic contacts which are not lithological contacts are allowed to not close. 

To differentiate between lithological contacts and tectonic contacts you can either directly enter this 

information during drawing, or you add the information after drawing by selecting multiple geometries. We 

use the field line-type and fill in either lith_contact or tect_contact. To add the information directly a window 

automatically opens after you finished drawing a feature (Right click on the map finishes drawing process) 

(Figure 30). 

The behavior of attributes can be changed in the “layer properties (right click on the layer in the layers tree) -

> “Attributes Form” (Figure 31). 
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Figure 30: Example: Entering the line_type = lith_contact in the Feature Attributes Window after finishing the drawing on the map. 

 

Figure 31: View of the Attributes Form tab in the Layer Properties where you change the behavior if the attributes window opens right 
after finishing the drawing on the map. 

To add the information after drawing, the easiest way is to select all the geometries which should get the same 

attribute and click on  “Modify the Attributes of all Selected Features Simultaneously” (Figure 32). 
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Figure 32: View of multiple selected tectonic contacts (use CTRL to select multiple lines) and the use of the tool "Modify the Attributes 
of all Selected Features Simultaneously”. 

When you are finished with the process, each line should either have the attribute lith_contact or 

tect_contact. To check this, you can take a look at the attribute table of the layer (Right click on layer in the 

layers tree and click “Open Attribute Table”). To demonstrate the two types of contact on your map, you can 

now use “Layer Styling”. Use a categorization with the value of your line_type and click on classify. Choose 

the colors according to your preferences (Figure 33). 

 

Figure 33: Simple categorization of the construction line layer using the information in the field “line_type”. 

Your map should look now like this (Figure 34): 
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Figure 34: Map View with the construction line layer activated and categorized into lith_contact and tect_contact. 

4.3.3. Checking for topological errors in the construction line layer 

QGIS 3 offers a built-in topology checker. In the case of the construction line layer this tool is very helpful to 

test if every line-geometry is closed. Open the topology checker panel by clicking on “Vector -> Topology 

Checker” (Figure 35). 

 

Figure 35: Opening Topology Checker in the Vector Tools. 

By clicking on “Configure” in this panel you can adjust the topology rules for any layer in your current map 

view (Figure 36). 

 

Figure 36: Configure the Topology Checker Panel. 

The rule you want to check for the construction line layer is “must not have dangles” (an endpoint which is 

not connected to another line is called a “dangle”) (Figure 37). 
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Figure 37: Adding the rule "must not have dangles" to the Topology Checker. 

To check for this rule now click “Validate All” or alternatively next to it “Validate Extent” if you only want to 

check in a specific area (Figure 38). 

 

Figure 38: Validating the rules of the Topology Checker. 

The errors for this rule will be shown in a table and, if “Show errors” is activated, also in your map view (Figure 

39). 

 

Figure 39: Errors to the rule "must not have dangles" shown as a table view and as red markers in the map view. 

Please remember that in our tutorial, the tectonic contacts are allowed to have dangles (see 4.3.2). Search for 

the errors of the lithological contacts and fix them by manually moving the endpoints of the lines (use 

snapping). Repeat the validation in the topology checker panel until no errors remain. 
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4.3.4.  Automatically fix topological errors in the construction line layer 

Next to the above-described manual way to fix topological errors in the construction line layer, we also want 

to show a more sophisticated way to automatically repair them. There are many options to get a job done in 

QGIS and the following procedure is mostly based on a good working practice. Besides the implemented 

functions of QGIS, it is also possible to access tools and scripts which are originally from another application 

(also see section 5). In this particular tutorial case we will use the tool v.clean of GRASS GIS (Gerdes et al.). As 

the scope of this tutorial is limited and concentrates on basics, the following explanations are a walkthrough 

and do not explain or go into the details of the tool and the parameters used. To open the v.clean tool, click 

on the “Processing” tab and then on “Toolbox” (Figure 40). 

 

Figure 40: Opening the Toolbox panel. 

In the “Toolbox”, the easiest way to find a tool is to type in a search parameter in the search bar (Figure 41). 

 

Figure 41: Using the search bar to find the tool v.clean in the Toolbox panel. 

Click on v.clean and enter the following parameters: Enter your construction_line layer as “Layer to clean”. 

Then click on the option menu in the “Cleaning tool” parameter and select “break, snap and rmdangle”. Back 

in the main window enter “Threshold: 0,5,5” (assuming that you are using a metric CRS) (Figure 42). 
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Figure 42: Screenshots of the parameters entered for cleaning the construction line layer with v.clean. 

At the end of the parameters window choose whether you want to “Save to temporary file” or “Save to file” 

and click “Run”. If the tool works correctly, you should now have produced a layer named “Cleaned” in your 

layers tree. Now you have to save your layer “Cleaned” to your gpkg. Right click on the layer -> Export -> Save 

Features As and name it adequately (e.g. construction_line_topo_fixed). For the following steps (creating 

polygons, etc.) you have to use this new line layer. (Figure 43). 
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Figure 43: View of the generated layer "Cleaned" of the tool v.clean and how to save it to your GeoPackage. 

4.4. Deriving the polygon bedrock layer 

To derive the polygon bedrock layer from the construction_line_layer the tool “Polygonize” in the “Processing 

Toolbox” is used. Open the tool by double clicking on it and enter as input layer the construction_line layer or 

construction_line_topo_fixed layer respectively (Figure 44). Press “Run” and a layer named “Polygons” should 

appear in your layers tree (Figure 45).  

 

Figure 44: Input parameters for the tool "Polygonize". 
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Figure 45: Temporary "Polygons" layer generated by the tool "Polygonize". 

The little box next to a layer looking like a bug  is indicating that this layer is temporary, meaning that it will be lost upon closing 
QGIS unless saved. 

If you are satisfied with your result (if every polygon was created) right click on the “Polygons” layer -> “Export 

and Save Features As” to save it to the vector.gpkg and give it an appropriate name like “bedrock”. Attention: 

If not all polygons are produced you have to go a step back and check the topology of your construction_line 

layer for proper closure of all line features. 

Next step is to add an attribute field to the “bedrock” layer to enter a unique identifier (HOLXXX) which also 

serves as a value for classification. As the aim is to describe geological units, the unique identifier will be a 

legend key (HOLXXX) which will be put into the attribute field. The description to the legend key will be added 

in the layer styling. Right click on the “bedrock” layer -> “Properties” -> Tab “Fields”. Toggle the Editing Mode 

 and click on the button left to it  “New Field” , enter the name “Leg_ID” and choose the Type “Text 

(string)” (Figure 46).  
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Figure 46: Adding the field "Leg_ID" to the bedrock polygon layer. 

In the main window click on your “bedrock” layer and Toggle Editing . Select all the geometries (hold 

CTRL) which should get the same attribute (Leg_ID) and click on  “Modify the Attributes of all Selected 

Features Simutaneously”(Figure 47). Follow this procedure by entering the “Leg_ID” according to the analog 

map or the final tutorial map until every polygon is filled out. 

 

Figure 47: Multiple selection of polygons which get the same Leg_ID (HOLXXX = unique identifier) and assigning of the Leg_ID in the 
Feature Attributes window. 
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Change to the layer styling panel or the symbology tab in the layer properties and categorize after “Leg_ID”. 

Now add the Legend text (= Description to the unique identifier) according to the analog base map, which are 

in this tutorial formations of Austrian Lithostratigraphy (you can also take a look at the final map and legend 

at the start of this tutorial). For each category choose a color and/ or pattern ideally following the colors and 

patterns of the analog base map (Figure 48).  

It is highly recommended to add the “Leg_ID” or any other unique identifier that is used to the legend text as well, since this allows 
for identical labels of the polygons in the map view and the corresponding legend text. This is especially important if similar colors for 
the different geologic units are used or the map is printed in grayscale. This way, there is a clear connection between the map and the 
legend via the unique identifier. 

 

Figure 48: Filled out legend texts in the layer styling panel. 

For adding labels change to “Labels” in the “Layer Styling panel”, click on the dropdown-menu and select 

single labels. Choose font, color, size and positioning to your liking (Figure 49).  

 

Figure 49: Using single labels with the unique identifier (Leg_ID; HOLXXX) in the bedrock polygon layer. 

Your map now should look similar to this (Figure 50): 
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Figure 50: Tutorial map with activated categorized bedrock polygon layer and labeled with the Leg_IDs. 

4.4.1. Copy the tectonic line layer 

As described above, the construction line layer was drawn using lithological and tectonic contacts. Both were 

used to derive the bedrock polygon layer. Only the tectonic contacts are now used to derive the tectonic line 

layer. This is a simple “select and save as” procedure. Right click on the construction line layer in the layers 

tree and open the attribute table. Now select only the rows with the value “tect_contact” in the field 

“line_type”. Close the attribute table and right click again on the construction line layer and choose “Export -

> Save Selected Features As”. Save the lines to your vector.gpkg and name it adequately (e.g. tectonic). Now 

follow the procedure as described in 4.4 to add an attribute field “Leg_ID”, select the different types of 

tectonic lines on your map, modify their attributes simultaneously, categorize them in the layer styling panel 

and add the Legend text – all based on the analog map (Figure 51).  

If you have trouble building or finding a convenient symbology in the Symbol Selector, see section 4.7.2, where the import of fonts 
from the Geological Survey of Austria (GeoSphere Austria) is explained. The fonts offer very useful symbology for geologic contexts. 

Your map now should look similar to this: 
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Figure 51: Map View with activated bedrock and tectonic layer. 

4.5. Drawing the quaternary polygon layer 

The next layer which will be drawn is an example of a polygon layer which is not derived from linework and 

represents the quaternary deposits of the tutorial area. First a new polygon-layer is generated. Follow the 

steps in section 4.3 to create a new layer in the vector.gpkg. Be sure to choose “Polygon” as Geometry Type 

and add a field named Leg_ID of Type Text(string) and name the whole layer adequately like “quaternary” 

(Figure 52). Load it into your layers tree. Keep in mind that this quaternary polygon layer does not have to be 

seamless as Quarternary deposits only partially cover the underlying bedrock, but it must not cover itself 

which correspond to the topological rule “must not overlap”. Speaking in a cartographic sense, it is important 

to avoid sliver polygons (see 4.1.3) which are in this case mostly produced when the outline of a quaternary 

unit comes close to a contact between bedrock units in the underlying layer. It is good practice to either use 

the contact line of the bedrock unit as well for the outline of the quaternary unit or to move far enough away 

from the contact line that no sliver polygon will be produced when the layers are stacked on each other. 
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Figure 52: Parameters of the newly added quaternary polygon layer in the vector.gpkg. 

Before you start drawing, it is highly recommended to organize the categorization (unique identifier = Leg_ID 

(HOLXXX) and legend text) of the different quaternary units in the attributes form tab in the layer properties. 

Right click on the quaternary layer -> Layer Propertiers -> Attributes Form. Click on Leg_ID field and choose 

Value Map from the Widget Type. Now enter the Leg_IDs (Value, unique identifier) and legend text 

(Description) in the table below. This controls (limits) the values you are able to choose when attributing your 

data and immensely simplifies data and attribution integration (Figure 53).  

 

Figure 53: Parameters in the Attributes Form tab to use a "Value Map" as Widget type to predefine the unique identifier (Value; 
HOLXXX) and the legend text (Description). 
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If your legend is already organized in another table you can use the Widget Type “Value Relation” to reference to that source. 

Now Toggle Editing  → Add Polygon Feature  and start “drawing” by clicking the desired spot on the 

map. Tools like Add Ring  from the Advanced Digitizing Toolbar help to create more complex geometries. 

Finish the new polygon by right clicking the map window. Whenever you are creating polygons adjacent to 

each other, Enable Snapping  and Tracing  to speed up the process and to create borders without 

holes and intersections. As you are working with a “Value Map” the values you can choose when you are 

assigning the Leg_ID (attribution) to your polygons is predefined (Figure 54). Remember that you can choose 

whether the attributes window opens right after finishing a polygon on the map via the dropdown menu in 

the top right corner of the “Attributes Form” tab. 

 

Figure 54: View of the Features Attributes Window with the predefined unique identifiers (values, -please note that shown here are 
only their descriptions-) stemming from the “Value Map”. 

At the end or any other point of drawing switch to the Layer styling panel and choose “Categorized” as method 

and Leg_ID as Value. The corresponding Leg_ID (Value) and the legend text (Description) that you defined in 

the “Value Map” in the “Attributes Form” of the layer will appear if you click on “Classify” as long as at least 

one geometry (polygon) is attributed with that Leg_ID. Now change the symbology to your liking, most 

preferably holding onto the colors and patterns of the analog base map or the final map of this tutorial. 

Now follow the procedure explained in section 4.4 to add labels of the Leg_IDs to your map, preferably in a 

different color than the labels of the bedrock layer to make them distinguishable. 

Your map should now look similar to this (Figure 55): 
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Figure 55: Map View with activated bedrock, tectonic and quaternary layer and labeling activated (unique identifier; HOLXXX) for 
bedrock and quaternary in different colors. Note that the bedrock layer is slightly transparent. 

For design reasons it can be very useful to make several layers transparent. This is accomplished in the “Layer Styling Panel” or 

“Symbology” tab in the “Layer Properties” using the option “Opacity” under “Layer Rendering”. 

4.6. Drawing the geomorphology line layer 

In addition to the construction_line layer (4.3.2) and the derived tectonic line layer (4.4.1) the tutorial project 

also contains a line layer which is drawn directly. This layer covers geomorphological units (e.g. moraine ridges 

and scarps of mass movements) which are represented as lines on the map. Start by following the steps 

explained in section 4.3 to create a new layer in the vector.gpkg. Be aware to choose “Line String” as Geometry 

Type and add a field named Leg_ID of Type Text(string) and name the whole layer adequately e.g., 

“geomorphology” (Figure 56). Load it into your layers tree. Toggle Editing  → Add Line Feature  and 

draw a new line by adding vertices to the map. Enable Snapping  and adjust its functionality in the 

Advanced Configuration . 
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Figure 56: Parameters of the newly added geomorphology line layer in the vector.gpkg. 

To get the attribution using the Leg_ID and the legend text as in all examples before, it is either to either follow 

the method of filling out the “Value Map” in the “Attributes Form” tab (see section 4.5) or to add the Leg_ID 

and legend text after you are finished drawing, similar to section 4.3.  

Change the symbology to your liking, most preferably holding onto the colors and pattern of the analog base 

map or the final map of this tutorial (Figure 57). 

 

Figure 57: Categorization using the Leg_ID and legend texts of the geomorphology line layer. 

Your map should now look similar to this (Figure 58): 
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Figure 58: Map View with activated bedrock, tectonic, quaternary and geomorphology layer. Note that the bedrock layer is slightly 
transparent. 

4.7. Point layer 

Points like structural geological orientation data, boreholes, springs, wells, geographical locations etc. can be 

defined directly within the project or added from existing files as well as automatically loaded directly from 

spreadsheets. 

4.7.1. Direct input 

As an example, the most important mountain peaks around the mapping area will be digitized. The goal is to 

create a point layer with the geographical location of the mountain peaks and their respective name. 

To locate the mountain peaks in QGIS use e.g.  the OpenTopoMap as a basemap. Add this map to the browser panel at the “XYZ Tiles” 
(https://tile.opentopomap.org/{z}/{x}/{y}.png). 

As mentioned before, a lot of ways lead to the desired outcome in QGIS. The following method to create a 

new GeoPackage layer does not follow the workflow of right clicking on the GeoPackage → New Table, as 

described previously. Nevertheless, it leads to the same result and we want to introduce an alternative, 

equally valid workflow.  

To create a new point layer in the GeoPackage, choose Layer → Create Layer → New GeoPackage Layer. 

Navigate to the previously created GeoPackage database. Call the new layer “geographical_location”, select 

“Point” as geometry type and, if not already set, choose the correct CRS. Below at the option “New Field”, 

type “mountain_peaks” in the name field and click on “Add to Fields List”. Now in the “Fields List” below a 

new field appears. Leave all other settings as they are and click OK. A window will appear asking if you want 

to “Overwrite” the Geopackage or “Add New Layer” → choose the second option. 
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Within the layers panel of your project, add a folder “Additional information” on top of everything else. Move 

the new “geographical_information” layer to this folder. By default, QGIS chooses a simple dot marker with 

an arbitrary color for newly added point layers. If you want to change the style, Right click → Properties → 

Symbology on that layer to enter the layer properties window or use the Layer Styling Panel.  

To add an additional attribute field like “Mountain_Height” to the layer Right click it and select Open Attribute 

Table. In the new window Toggle editing mode  and click New Field . Within the “Add Field” window, 

enter a name for the new column, leave the type “Whole number (integer)” as it is. (Figure 59). 

 

Figure 59: Adding a new attribute. 

For adding, removing, and general editing of GeoPackages (or Shapefiles), the editing mode must be activated. 

To add a point to the map, press the Add Point Feature button  within the digitizing toolbar. After clicking 

the desired location in the map window, a small window appears where you can assign attributes to that 

feature. 

Now its possible to add more geographical locations, springs, etc. to the map and fill in the respective attribute 

of the features. Safe your edits and deactivate the layer’s editing mode. To label the layer, Right click on it and 

select Properties → Labels. Change the selection to “Show labels for this layer”. In the drop-down menu of 

“Label with”, select the “name” attribute and press OK (Figure 60). 
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Figure 60: Adding labels to point layers. 

Again, it is highly recommended to play with all the possibilities for style and label customization. For example, the function 
“Buffer”=> “Draw text buffer” can help increase text readability. 

With this method, a variety of highly customizable point layers can be added to the map. By now your map 

should look similar to Figure 61. 

 

Figure 61: Current map with newly added mountain peaks as a point layer. 



48 

4.7.2. Structure point layer - Importing data from text files 

Geolocated point data (e.g., structural geological measurements, well locations etc.) are often stored as a text 

file which can be imported into QGIS. The advantage of using text files as data sources is that if the data source 

changes (e.g. new measurements are made), the point layer is updated within your project (when QGIS is 

restarted, or the layer is reloaded). 

In the example project, structural measurements are given in the file “measurements_EPSG_31257.csv”. 

Please note that the EPSG code is added to the name of the csv. This is highly recommended because you have to know the CRS of the 

imported data, no matter in which CRS your project is set up (QGIS automatically transforms on the fly into the project CRS). In this 

tutorial case, the project CRS is 31287 and different from the CRS of the measurements.csv. 

In total, it contains six measurements of bedding plane orientations, one of which is an inverted bedding. To 

show the orientation of planes with strike/dip symbols, a text file with at least four columns is needed. Usually, 

an additional column with the type of the measurement (i.e.: bedding plane, joint, fault…) is given (see Table 

2) and can be used for a classified symbology (see e.g. section 4.3.2 for an explanation on classified symbology) 

Table 2: Example of a text file with five columns, containing geolocated structural geological measurements. 

type dip_dir dip X Y 

bedding 140 80 156657.9 240685.3 

bedding 128 60 155790.5 240445.5 

Bedding 
overturned 

330 65 156030.2 240276.3 

… … … … … 

To add data from a text file either use Add Delimited Text Layer  within the Manage Layers Toolbar or go 

to Layer → Add Layer → Add Delimited Text Layer … from the Menu bar. Adjust the settings of the Data 

Source Manager | Delimited Text window to match your file (Figure 62) and Add the points to the map. 



49 

 

Figure 62: Adding a delimited text layer to the project; common error sources labeled 1.-4. 

Common sources of confusion are (labeled 1-4 in Figure 62): 

1. unknown/wrong custom delimiters of the text file (when in doubt: right click and open the text file with a text editor instead 
of spreadsheet applications to see what the delimiter between columns is) 

2. number of header lines to discard is not correct 
3. wrong columns for X- and Y- coordinates are selected, or X and Y coordinates are switched. If this happens, points will 

usually plot far away from their expected location and are 90° rotated. You can check if points are located far outside your 

basemap by right clicking the new layer and clicking Zoom to Layer  
4. wrong CRS is chosen for the geometry of the text file (this CRS does not necessarily have to fit your project CRS) 

 

4.7.3. Rotated structure point symbols 

The point layer’s symbology can be changed with Right click → Properties → Symbology or at the “layer 

styling panel”, as described above. However, structural measurements such as the dip direction on geological 

maps normally have special symbols that are not commonly available in the symbology options. As the symbol 

for the dip direction resembles the letter “T”, a commonly used workaround is to use this letter. For that, 

choose a “Font marker” instead of the “simple marker”. Change the “Fill”- and “Stroke color” to black, choose 

a visible size and select the letter “T” as symbol. 

Alternatively, the Geological Survey of Austria (Geosphere Austria) provides special fonts for geological 

applications, such as dip direction, strike and other directional symbols. The font and styles can be downloaded 

from the “Symbology” tab at http://gisgba.geologie.ac.at/LegendGenerator/. Once downloaded, the font files 

must be unzipped and installed. In Windows 10, double click the fonts you want to install. Click “Install” in the 

window that pops up, and then click the “X” in the top-right to close the window. Now, the newly installed 

fonts should be selectable in the Font family drop-down menu. 

http://gisgba.geologie.ac.at/LegendGenerator/
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To rotate the chosen symbol according to the dip direction, click the Data-defined override  button 

besides the “Rotation” input field and choose the name of the dip direction – column of your data (Figure 63). 

 

Figure 63: Setting the symbol rotation according to the dip direction of the point. 

By clicking Apply, your symbols are rotated, but may be offset by 90° or 180° (depending on the chosen 

symbols). To correct this, choose Edit (Figure 63 - top) and enter >180 + “DipDirection”< in the Expression 

String Builder (or whatever your dataset’s column with the dip direction is called) (Figure 63 - bottom). If you 

have chosen a letter that is already rotated by 180°, this step is not necessary. As a last step, choose the “Dip” 

column as label for the structural geological measurements (Right click on the layer, select Properties → 

Labels and change the selection to “Show labels for this layer”). 

Instead of “font markers”, “SVG markers” can be used, as well. Scalable Vector Graphics (SVG) can be created with different graphic 

programs and allow you to design your own markers from scratch. 
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Figure 64: Workflow to rotate point layer symbols by 180°. 

By now your map showing the bedrock polygon and the structure points should look similar to Figure 65: 

 

Figure 65: Map View with activated bedrock and structure layer. Note that the bedrock layer is slightly transparent. 
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4.8. Final tutorial map 

Finally, all the geometries are brought together and visualized in the drawing-order (bottom to top) bedrock 

– tectonic – quaternary – geomorphology – structure – Mountain Peaks (Figure 66). It is now a good idea to 

play around with the opacity or labeling of the layers to generate the outcome you are most satisfied with. As 

the topology and cartography rules explained in 4.1 were followed, it is now possible to export a correct 

“classic” planar map as an image or layout (see section 6). Furthermore, using the method of splitting up the 

geological information into different layers allows you to export maps for more specific topics (e.g. bedrock + 

tectonic + structure).  

 

Figure 66: Final map with all the geometries produced during the tutorial activated. Note that the bedrock layer is slightly transparent. 
The DEM (rendered as a hillshade map) produced in section 3.2 is used as a basemap. 

5. Adding Additional Map Content with Plugins 

While QGIS contains every functionality for basic map creation and many additional, more specialized 

components, the program’s functionality is even further extended by inclusion of third-party plugins. These 

plugins can be created by everybody and there is already a large library of existing plugins. The advantage of 

third-party plugins is that they often provide highly domain-specific features that suit one specific application 

of a discipline (e.g. generating geological cross section from a map, see below). The downside of them is that 

they are also “community maintained” which means that their support might be limited and finite. It thus can 

happen that some third-party plugins unfortunately “expire” and cease to function when the plugin 

maintenance cannot keep up with the development of QGIS. This especially affects many plugins after major 
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updates to QGIS, such as the transition from QGIS 2 to QGIS 3. Below, the usage of one exemplary plugin is 

explained in detail. 

5.1. Auto-generating geological cross sections with qProf 

A very common task after the creation of a geological map is to derive cross sections from this map. In QGIS, 

the external plugin qProf was designed to support users with this task. With this plugin, it is possible to create 

a topographic profile from an elevation model or elevation information containing gpx points and a defined 

profile line. The big advantage of this tool is that it is possible to transfer geological information from the map 

to the profile. Geological data, such as stratification attitude and geological traces, can be projected onto the 

profile and intersections between geological outcrops or faults can be determined. To use this plugin, it must 

be installed first. This can be done under the Tab “Plugins” → “Manage and Install Plugins...” in the QGIS 

GUI. Within the new “Plugins” window, type “qProf” into the search bar, select “qProf” from the search results 

below the search bar, then click “Install Plugin”. After installation, the plugin appears under the Tab “Plugins”. 

When you now open the plugin, an additional window next to the processing toolbox appears (Figure 67). On 

the top, several tabs represent the different workflow steps. The tab “Help” includes a detailed description on 

how to create a (geological) profile. The profile line can be created within the plugin or an existing line can be 

used. As output, a height diagram with the additional geological information can be exported in different file 

formats (svg, tif or pdf) for further processing (Figure 67). The final cross section must be drawn manually 

either by hand or within a vector graphics software. 

Inkscape is a good open source option for a vector graphics software. 
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Figure 67: The qProf plugin can be used to create cross sections from elevation data including geological information from a map. 

For additional information, see https://github.com/mauroalberti/qProf and https://inkscape.org 

6. Layouts 

After you have finished adding information to you map, you will likely want to export it as an image file for 

display or printing. So far we used the CRS EPSG 31287 MGI Austria Lambert through the whole project as 

explained in section 2.3. This CRS is not ideal for displaying our map, as it is results in a noticeably rotated map. 

In the area covered by the tutorial data, a better fitting CRS is EPSG 31257 MGI Austria GK M28 (Figure 68). 

Changing the CRS is done in Project -> Properties -> CRS.  

https://github.com/mauroalberti/qProf
https://inkscape.org/
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Figure 68: Using the project CRS EPSG 31287 (left) the view of the data in an exported map would be slightly tilted. Therefore, EPSG 
31257 (right) is used during export. 

A “quick and dirty” way of exporting maps from QGIS is Save Map as Image which can be found in Project (do 

not forget to scale the resolution appropriately). To produce a proper map, however, a “layout” needs to be 

created that – besides the map itself - contains elements like a legend, North arrow, scale etc. 

6.1. 2D Maps 

Any geological map needs at least a legend, a scale bar and a north arrow. To create such a map, select Project 

→ New Print Layout  in the Menu bar and name your map layout. Upon confirmation, the Print Layout 

window opens (Figure 69). 
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Figure 69: Print Layout window with several GUI elements: 1. Menu Bar; 2. Toolbars; 3. Items Panel; 4. Layout Panel (and other panels); 
5. Item Properties Panel (and other panels); 6. Toolbox. 

First, Right Click the empty page of the map window and select → Page Properties. Within the Item Properties 

panel, you can change the overall properties (height, width, orientation…) of the page. To add a new map, 

choose the Add a new Map to the layout  button within the toolbox and draw a boundary box onto the 

empty page. Your main map window (with all active layers) will now appear. The displayed map corresponds 

to the active layers in your main QGIS window.  

Note that you can add more than one map to your layout.  

Clicking Move item content  in the toolbox allows you to zoom in and out by scrolling and to move the 

whole map content within the boundary box.  

After you have found an appropriate scale and the right area of the map, it is recommended to lock the map item within the Items 

Panel (by checking respective the box in the column marked with a lock symbol  ) to avoid accidental shifting of the map content. 

Every item of the map has its own Item Properties Panel which can be used for manual customization. For 

example, you can choose your map’s scale (e.g., 1:15 000) or add features like a frame, background or 

coordinate grid. To add a grid, go to the “Grids” section of the Item Properties Panel of your map, click Add a 

new grid, activate Draw “Grid 1” grid and click Modify grid… (Figure 70) 

 

Figure 70: Adding a grid to the map. 

Within the Map Grid Properties, the grid itself can be customized and for this tutorial’s map the following 

parameters were chosen: Grid type: solid, CRS: EPSG:31257, Interval Units: Map Units, Interval (X,Y): 1000,00.  

Do not forget to provide the note the CRS’s name as in a text box on your map. 

Click Add a new Scalebar to the layout  and place it on the map. Modify the item properties to enhance 

visibility. A North arrow is simply added by clicking on the Add North Arrow  symbol in the layout toolbox 

(normally located on the left hand side of the layout window). After placing the arrow, you can choose from a 

number of different arrow styles under Item Properties, or import a new image file.  Add a new Legend to the 
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layout  and place it accordingly. By unchecking “Auto update” within the Item Properties panel of the 

legend, you can manually edit the legend-content. By using the described tools of the toolbox, you can easily 

add further content to your map and make it look more appealing and add additional information to it. By 

clicking Layout → Export as Image  or Layout → Export as PDF  you can export the map. In the Image 

Export Options, you can choose the export resolution, if you want to create a world file (for georeferencing of 

the map-image) and if you want to enable antialiasing (for smoother graphics) ( 

Figure 71). 

The final map is presented in Figure 3, at the beginning of this document. 

 

Figure 71: Image export options. 

 

6.2. 3D Maps 

A major new feature in QGIS 3 is the possibility to visualize maps in 3D. Three dimensional visualizations of 

geological maps can serve the purpose of checking if the digitized lines really fit to the topography (this can 

be especially relevant for mapping of unconsolidated sediments). It further provides a more intuitive view of 

the landscape and the underlying geology which helps to illustrate and communicate geological information 

and models. 

To start a new 3D view of the map, go to View → New 3D Map View. A new window will pop up and QGIS will 

start to load the 3D view of the map. Within that window you can modify the 3D view by either panning the 

view (left mouse button), zooming in and out (either right mouse button or mouse wheel rotation) or rotating 
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the view (holding down the mouse wheel while moving the cursor). By default, the 3D view is just a 2D plane, 

so the Options of the 3D view need to be modified to get a “real” 3D visualization (red arrow in Figure 72). 

 

Figure 72: 3D Map view of the tutorial. The default view was modified to show the 2D map - plane in 3D. 

To do this go to Options → Configure ... and within the new Options window to Terrain. Within the Terrain 

section the setting “Type” needs to be changed from the default “Flat Terrain” to “DEM (Raster Layer)”. After 

doing that the possible selections in the window change and you also need to specify which raster layer should 

be used to derive the 3D height information. In the case of this tutorial we set it to the DEM layer where all 

the initial DEMs were merged into each other (see section 3.2.3 and Figure 73). 
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Figure 73: 3D configuration to get a 3D visualization of the geological map over a DEM. 

After confirming, you might have to modify the 3D view again to get the final 3D visualization (Figure 74). 

 

Figure 74: 3D visualization of the mapped area over a DEM. 

To finally export the 3D view as an image file, you can either use the Save as Image ... button within the 3D 

Map view, but this only allows to save visualizations with a screenshot’s resolution. To save a high resolution 

visualization, set up a new print layout as described in the previous section. Select the Add 3D Map button 

and draw a new 3D Map window on your layout. To connect the 3D map window with the previously created 
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3D Map view, you have to go to the Item Properties of the 3D Map (1 in Figure 75) and then select the 

previously created 3D view under Scene Settings (2 in Figure 75). After some loading time the 3D view will 

appear in the map window. You can then add further “decorations” to the visualization and finally export it 

with the desired resolution as described in the previous section (Figure 76). 

The appearance of the 3D view depends completely on which layers you have activated in your main map 

window. The example in this section was created by setting the geological map to be slightly transparent and 

showing it on top of the previously generated isolines and the hillshade view of the DEM that was imported 

as a WMS layer. 

 

Figure 75: Setting up a layout to get a 3D visualization with high resolution. 
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Figure 76: Final 3D visualization of the case study of this tutorial. 
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Supplementary Information 

The tutorial data for this guideline is available under the following link: 

https://repository.tugraz.at/records/57kxm-

w5t95?token=eyJhbGciOiJIUzUxMiJ9.eyJpZCI6Ijk0MDQ2NjRiLTM2OGQtNGVlMC1iNWZmLTA5N2M5YWFkNz

NlZSIsImRhdGEiOnt9LCJyYW5kb20iOiI1YTJhNzJiM2Q5MjRhOTc3ZTliODA1NjhlMTNjOTI5YSJ9.AUAmv39oYNv-

v6hO3A5538p234Q3J3fgvp0X1kg6BXoE5a_8P2K6rYfzlH-EY67RBibkjPYkc6K_Zr6GS9WGBA  
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